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Utilizare soft-uri specializate in Kineto

: Marti 12-14

Activitati:

e 2 Ore curs,

* 1 ore laborator,
(prezenta obligatorie)

» Mail: Per@cs.ubbcluj.ro,

» \Web:

Cursuri

Teme
L_aborator

Data

— Biroticd, Multimedia, Windows

Windows

s

— Word-1 ’

> Word ,

Word ,

Word ,
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File : New, Open, Close, Save, Save As, Print,... , Exit

Edit : Find, Replace, ...

View : Toolbars, Header and Footer, ..., Zoom

Iasert : Break, Symbol, Reference, Picture, File, Object, Bookmark, Hyperlink, ...

Doc. cu mai multe sectiuni (cu propr. diferite),
Numerotare pagini, Dta&Timp, Car.Sp., Comentarii
Referinte — Antet/subsol/Sf.doc., Numerotare-Den.fig., Referinte (incrucisate),

— Index cuvinte(notiuni), Cuprins, Lista Figuri/Tabele, ...
Picture, Diagram, Textbox,
File, Object,
Bookmark,
Hyperlink.

5. Office Word 2007: File, Home, Insert, Page Layout, References, Mailings, Review, View

Curs 3. - ... — Microsoft Word_,, —...
1. Format:...
2. Tools: ...
3. Window: ...
4. Help: ...
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1. File :

Eile | Edit View Inset Format Tools Table

MNew...
Open... Ctrl+0

Close

Save Ctrl+5
Save As,.,
Save as Web Page...

File Search...

e o kb

1. i)

Verzions...

Permission 3

Web Page Preview

Page Setup...
Print Preview
Convert to PDF

=4 Print... Ctrl+P

Send To 3

Properties

1 ChUsers\PerfitPer\Doc Nessielindexhtml
2 ChlUsers\Perfi\Per\Doch..\MUCILE.doc

2 ChUsers\Perfi\Per..\Grey Scale.doc

4 ChUsersh.. \Rferate Alese - 2.doc

Exit

Save As
Save n: c2 E\Qv_ﬁ Q X i ZF v Tools ~
T Name Date modif., Type Size Tags
’ ~Sindows,DOC N BIROTICADOC
[ My Recent Microsoft Word Document @ J ficrosoft Word T
Documents 4 iouly sy 36.0 KB )
- @ Carte Word.Doc @ = Windows.DOC
| Dedop s it e
| W Word_1.00C W & Word_2.00C
| | My Documen
‘ @ Word_ll‘)OC h
Ay sAOMB
‘ My Computer
| WY
o | ok g
My Network = ; <
Places SRSl Word Document (*.doc j | Cancel I
Print (D ]
Printer
e[ 5 [ B
Status: Idle ‘ Find Printer...
Type: PDFcamp Printer
Where: PDFcamp1: [ Print to file
Comment:  http:/fwww.verypdf.com [] Manual duplex
Page range Copies
@ al Number of copies: 1 &
() Current page
(7) Pages: 1? 1? [¥] collate
Enter page numbers and/or page ranges
separated by commas. For example, 1,3,5-12
Print what: |Document E] Zoom
Pages per sheet:
Print: All pages in range B S e 1page El
Scale to paper size: | No Scaling [~]
Options... [ OK J [ Cancel J

Page Setup

Margins | Paper [Layout

Margins
Top: 1] =
Left: 125"

Bottom: 1° o
Right: 1.25" v
Gutter: 0" 3 Gutter position: Left Tl

Orientation

A

~portrait
Pages
Multiple pages:

Landscape

Normal 3

Preview
Apply to:
Whole document

[=] =

Default... |
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1. File :

* New

Open

Close

Save

» Save As ...

Page Setup ...

e Print ...

« EXit

-:.'. As

Save in:

My Reoent
Documents

-

My Computer

L

My Network
Places

IR s ¥ == >

| c2
Name Date modif... Type
W - ~Sindows.DOC
~d-—— | Microsoft Word Document
| — | 162 bytes

m > Carte Word.Doc
Microsoft Word Document
582 MB

m > Word_1.D0C
Microsoft Word Document

372MB

m > Word_3.D0C
Microsoft Word Document
4.49 MB

Size

-\

[l @-31@ X ci 6 ook -

Tags

BIROTICA.DOC
Microsoft Word Document

| 36.0 KB

Windows.DOC
Microsoft Word Document

| 1.04 MB

Word_2.00C
Microsoft Word Document

| 5.42 MB

File name: IOp_Cdc.doc

Save as type: '«'u'ord Document {
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1. File :

* New
¢ Open rPage Setup L@_I-K_hj
» Close Margins | Paper I Layout |
Margins
L Save Top: 1] = Bottom: | 1" %
Left: 1.25" = Right: |1.25" =
o Save AS v Gutter: 0" % Gutter position: |Left B
Orientation
[
A Al
* Page Setup S Portrait Landscape
Pages
Multiple pages: Normal E
° Margins 9 Previelw
Apply to: —_—
Whole document E :=

« Print ... o

-~

] I Cancel

e Exit
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1. File :

 New

» Open
C|OS€ rPage Setup M

{ Margins ] Paper l Layout ]

» Save .
Paper size:
_EI
°
Save As ... o = &
Height: 11.69" o
* Page Setup ... Paper source
First page: Other pages:

Default tra - Default tra 4
Wi T Automat :ﬂ‘r.l?— Automatically Select
> Margins —

° Paper 9 Preview

Apply to:
Whole document E]

* Print ... (

(@]
~

] [ Cancel

e Exit
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1. File :

 New

Open

Close

Save

Save As ...

Page Setup ...
> Margins —

s Paper —

Layout =

 Print ...

e Exit

~
Page Setup

i Margins Paper

| {Tayout ;

Section
Section start:

Preview
Apply to:
Whole document

New page

nress endnotes

Headers and footers

, ] Different odd and even
|| Different first page
From edge: Header: |0.5"
Footer: |0.5"
Page
Vertical alignment: Top

[=]

[ Line Numbers...

J [ Borders... ]

0

-~

] [ Cancel
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1. File :

* New
* Open :
Print D (3]
» Close o
rinter
. Save e | [T =]
ZanE e : Find Printer...
Type: PDFcamp Printer
e Save As ... Where: PDFcamp1: [ Print to file
Comment:  http:/fwww.verypdf.com [] Manual duplex
Page range Copies
@ All Number of copies: 1 =
° @) Al c =
Page Setup e (") Current page Selection
(7) Pages: 1? [V] collate
Enter page numbers and/or page ranges
separated by commas. For example, 1,3,5-12
® Pl'lnt [N Print what: |Document [Zl £008
. Pages per sheet:
Print: All pages in range E’ B 1page E]
Scale to paper size: | No Scaling E|
. .
EXIt Options... [ OK ] [ Cancel J
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2. Edit:

Edit I View Insert Format
¥} Undo Typing Ctrl+Z
= \ Redo Typing  Ctrl+Y

Undo
Redo

& | Office Clipboard...
Lﬁ} Paste Ctrl+V

Paste Special...

* Find ...

| Paste as Hyperlink

Clear »[ | « Replace ...
Select All Ctrl+ A
33| Find... Ctrl+F
{ Replace... Ctrl+H ° GO TO ce
Go To... Ctrl+G
Reconvert
K °

Find and Replace

Find (Reglace I Go To ‘

Find what:

[ Highlight all items found in:

M=zin Dariiment
il Lol '4""\,4_

Search Options

Search: All E

[] Match case

[”] Find whole words only

["] Use wildcards

["] sounds like (English)

("] Find all word forms (English)
Find

[ Format ~ } [ Spedal v J
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2. Edit:

Edit
)
d

b

View Insert Format

Undo Typing Ctrl+Z
Redo Typing  Ctrl+Y

Office Clipboard...
Paste Ctrl+V

Paste Special...

' Paste as Hyperlink

Clear »
Select All Ctrl+ A
Find... Ctrl+F

' Replace... Ctrl+H
Go To... Ctrl+G
Reconvert

(@

Undo
Redo

|
rnd ...

Replace ...

GoTo...

Find and Replace

Find what:

Replace with:

Search Options

Search:
| Match case

[ Use wildcards

Replace

‘ Find ‘ Replace 1 Go To ‘

Ceva B
Similar]| E]
[ Less 2 ] [ Replace ] [ Replace All ] [ Find Next ] [ Cancel

]

Al -]

[ Find whole words only

[] sounds like (English)
"] Find all word forms (English)

[ Format ~ ] [ Special ~
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2. Edit

Edit

“)
o

af)
oo

View Insert Format

Undo Typing Ctrl+Z
Redo Typing  Ctrl+Y

Office Clipboard...
Paste Ctrl+V

Paste Special...

' Paste as Hyperlink

Clear »
Select All Ctrl+ A
Find... Ctrl+F
Replace... Ctrl+H
Go To... Ctrl+G
Reconvert

cind ..
Renlace
KEDLlaCce

GoTo...

Find and Replace

‘ Find lReQIaceJ' GoTo l

Go to what:

Section
Line
Bookmark
Comment
Footnote
Endnote

lm |

Enter page number:

Enter + and — to move relative to the current
location. Example: +4 will move forward four

items.

Previous ] [
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3. View :

View I Inset Format Too

Print Layout
44 Reading Layout
Z Outline

Task Pane  Ctrl+F1

Toolbars »

Ruler
\ﬂ

Document Map

_] Header and Footer

Markup

HTML Source
=l Full Screen

Zoom...

Toolbars ...

L

Zoom...

j

iew | Insert Format

Tools Table Window Help

Normal

Web Layout
rint Layout
Reading Layout

AR ] o
o

Task Pane  Ctrl+F1

| Fe Ve SR R

| RETT AT PR TR PR |

Toolbars

'

Standard

Formatting

Document Map

Thumbnails

AutoText

Control Toolbox

‘ Ruler
Ql
i
=l

Header and Footer
7| Markup

HTML Source
=} Full Screen

Zoom...

Database
Drawing
E-mail
Forms
Frames

Mail Merge

Outlining

Picture

Reviewing

Tables and Borders
Visual Basic

Web

Web Tools

Word Count
WordArt

Customize...
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3. View :

1<

iew I Inset Format Too

Normal

Web Layout
Print Layout
Reading Layout
Qutline

g Ulele

Task Pane  Ctrl+F1

| Toolbars »

Document Map

i Ruler
Ql
!

Header and Footer

Markup

‘ HTML Source
=) Full Screen

Zoom...

Toolbars ...

L

Zoom...

>

Customize

:

E | Drawing
f | Drawing Canvas
|” | E-mail

1_ i Extended Formatting

\_' | Function Key Display
£ J Japanese Greetings
[ mail Merge

New...

Reset

[ Keyboard...

J

Close ]
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3. View :

View | Inset Format Too .
=N Normal Customize @&J
LA L [ J
Bl W - F——————
S| Web Layout ‘ m Options ‘
-|  Print Layout
J - y To add a command to a toolbar: select a category and drag the
4 Reading Layout command out of this dialog box to a toolbar.
. Categories: Commands:
Z| Outline ° =
Toolbars ... GO - | (3] new.. -
Task Pane  Ctrl+F1 Edit (T w
View (=1 | 37 New
Toolbars » Insert [T
= Eg:é #] New Web Page
%) Document Map Web 32| New E-mail Message
B Thumbnails ° Window and Help
- e Drawing ~| | ] New Blank Document =
Header and Footer -
Modify Selection ~ [&earrange Commands... J
Markup
HTML Source
3| Full Screen e Z00OMm... Save in: |Normal.dot [Z' { Keyboard... 1 [ Close ]
Zoom...
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3. View :

View | Inset Format Too .
=] Normal Customize @Iﬂ_&]
- . e o o
Bl W . - 1
| Web Layout | Toolbars l Commands
=|  Print Layout
J - _ ¥ Personalized Menus and Toolbars
il Reading Layout [] show Standard and Formatting toolbars on two rows
2| Outline ° TOO]baI‘S e [] Always show full menus
Task Pane  Ctrl+F1 (V] Show full menus after a short delay
Toolbars > Reset menu and toolbar usage data
Ruler Other
Q.1 Document Map [ Large icons
S . [¥] List font names in their font
: — e [¥] Show ScreenTips on toolbars
]| Headerand Footer [] show shortcut keys in ScreenTips
- Menu animations: | (System default) B
Markup
HTML Source
= Full Screen e ZOOMm... [&eyboard... 1 [ Close ]
Zoom...
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3. View :

§E|Ie Edit View Inset Format Tools Table Window Help

Type a question for help -

Bgm |

AN =

WA DERE T N TV SR e Ry

[:__I Print Layout
44 Reading Layout
|| Outline

Task Pane  Ctrl+F1
Toolbars >

Ruler

\ﬂl Document Map

[ Thumbnails

_] Header and Footer

E::: otnotes

Markup

HTML Source
QI Full Screen

Zoom...

L

Header and Footer

Zoom...

Insert AutoText- | ) 8 47| B1 O |10 )] | E 3 5, Close §

o 1 Pov v 200

21:2322 24/1022010}

01)e>‘¢.r'ré pe calculator 2809/2010,Sem. I+~

fr " Cuss ~ Sgi

a | ¢ | o
| 27.00.2010] 11.10.2010 | 25.10.2010 |
- -

Modul de evaluare:

L1l Informsatii generale déSprecurs, seminar, lcrare practica
sailaborator

12 Informatii despre titwlarul de curs, seminay, lucrarg practicd &
sau laberator:

Footer

Bt e S n e =R = B~ = e s e o =

iFooter

Page 1 Sec 1




3. View :

View | Inset Format Too

-El

Print Layout
Reading Layout

Qutline

Task Pane  Ctrl+F1
Toolbars

Ruler

Document Map

Header and Footer

Markup

HTML Source
Full Screen

Zoom...

L

« Zoom...

7

Zoom
Zoom to
") 200% ") Page width @ Many pages:
1 100% ) Text width
75% ) Whole page — 5
Percent: 68% =
Preview =
12ptTime] 1 y > Pages
AsBboroure=acryzz
AsBbCcDdE=XxYvZz
AaBbCcDdE=XxYvZz
AaBbCcDdE=XxYvZz
T L v

OK ] L Cancel
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4. Insert > Break:

Insert | Format Tools Tab
Break.. =3 |l p | 2 % )| | ] Ex C3.doc - Microsoft Word SNACE X
E ; Eile Edit View Insert Format Tools Table Window Help x
] Break types
Date and Time... 3 SRR = REWENE N S IR R & j 0% - H A 'H
AutoText » Column break [] .E. P20 141 1B 1B 1A —
Field... Text wrapping break -
Section break types ]
Symbol... Portrait
MNext page -
4 Comment )
ety Continuous - |
Reference » Even page - Landscape E
Ddd page -
Picture » oK ] | Cancel T ~
23| Diagram.. -
A1 Text Box . 7
+
File... .
Object... F
=nE|=8 « 1 b
Bookmark... - . = 000 d| & A -
: Draw ~ AutoShapes - “u, = R R N
@ Hyperlink..  Ctrl+K S p =
Page 2 .: Sec 2 :. 2/2 At 1.2" Ln 1 Col 1
* *

AT
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4. Insert > Page Numbers:

Insert

Format Tools

Tab

Break...

Page Mumbers...

——

el
[
21

i

=]

Date and Time...
AutoText

Field...
Symbaol...

Comment

Reference

Bicture
Diagram...
Text Box
File...
Object...
Bookmark...

Hyperlink...  Ctrl+K

!
Page Mumbers |-_EE | Page Number Format l_J—éIi-
e |Z| Preview Number format: 130 B
Bottom of page (Footer)
Al : — V| Indude chapter number
Alignment: ; :
Right IZI — Chapter starts with style  |Heading 1 E]
U tor: =
| Show number on first page ' S RO thyphen) B
Examples: 1-1, 1-A
2 | | Cancel | | Page numbering
Continue from previous section
@) Start at: ;' 5o s
[ OK ] { Cancel ]
=
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4. Iasert > Date and Time:

lnsertl Format Tools Tab

Break...
Date and Time... —
AutoText >
Field...
Symbol...

4 Comment
Reference >
Picture >

¢4 Diagram...
Al Text Box
File...
Object...
Bookmark...

Hyperlink...  Ctrl+K

Date and Time

Available formats:
19.03.2010

vineri, 19 martie 2010

19.03.10
2010-03-19
19-mar.-10
15,/03/2010

19 rmar. 10
18/03/10

martie 10
mar,-10
19.03.2010 13:15
19.03.2010 13:15:44
13:15:44
1:15:44

13:15

Default. ..

Language:

= | |Romanian (FRomania) IZI

Lipdate automatically

0K ] | Cancel
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4. Insert - Symbol:

lnsert' Format Tools Tab

Break...

Date and Time...
AutoText >
Field...
Symbol...

Comment

Reference >

Picture >
Diagram...

Text Box

File...

Object...

Bookmark...

Hyperlink...  Ctrl+K

Symbocl

Symbols |Sgecial Characters |

Font: | T =

NIIJ|R p|® ST nju|lD|olc|clcle| e
Z|IVI®e|™MITI|V| - |=|A|v el = U
ol¢l@le|™iz| (|| [T L]M[]L]]
O I T e
Recently used symbaols:

Bz |s|v|Ble|n|uln]|al<|o]=]1

Symbal: 206

Character code: | 206

|5utoCurrer_t... | |Shurtcutﬂey... | Shortcut key:

from: | Symbal {decimal)

[=]

IME Pad

[ Insert ] |

Cancel |
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4. Iasert -~ Comment:

lnsertl Format Tools Tab

Break...

Date and Time...

{ fammant [A1]): Commeant

AutoText >
Administrator, 3/19/2010 1:37:00 PM
Field... commented: —
Symbol... Comentariu
4| Comment ) [FDI‘ITaIIl ________________ E_,;e{Commnt[AIJ:ggg‘mm ]
7Rc-fe}egce >
Eicture >
2.2 Diagram...
A] Text Box [Partrai’r‘
File...
e & Paste.......
e R "l‘g--ﬁdit Comment ......"~“
R [Pesink.. QK " .| 24| Delete Comment ““':
'R'--Eaﬁ.............--"
=% Paragraph
:=  Bullets and Numbering...
?:_?_,_J Hyperlink...
gl Look Up...
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4 . IﬂSe l"'t - Refe['eﬁce - Footnote / Endnotes :

lnsertl Format Tools Tab

4

s
<o
e

T

Break...

Date and Time...
AutoText »
Field...

Symbol...

Comment

Reference ——> »

éicture 7 »
Diagram...

Text Box

File...

Object...

Bookmark...

Hyperlink...  Ctrl+K

Footnote...

Caption...

—

Cross-reference...

Index and Tables...

#

Footnote and Endnote

)

Location

Endnotes:

Format
Mumber format:
Custom mark:
Start at:

Mumbering:

Apply changes
Apply changes to:

Bottom of page IZI

1,2,3, .. |
Symbol... |

1 5

Continuous IEI

This section |E|

Insert

] | Cancel

.
.
®%ecee

Landscape’
Autor’

* Noti de subsol
... 7 Altd Notd
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4. Iasert > Reference - rootnote:

Insert I Format Tools Tab
l Break...

Page Numbers...

Date and Time...

AutoText >
Eield...
Symbol...
-2‘ Comment Footnote... Capticn ﬁ
| Refere.ﬂce —> ) Caption... — —
_.1‘ Web Component... Cross-reference... Figure 1 — |
Picture 4 Index and Tables... Options
#.% Diagram... Label: Figure IZI
AJ) TextBox Position: |Below selected item |E|
File...

[ Exdude label from caption

Object... _

Bookmark...

ggb Hyperlink..  Ctrl+K | ok || cancel |
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4. Insert - Reference - cross-ieference

lnsert] Format Tools Tab
Break...

Page Numbers Current Document
) - --= CTRL + click to follow link

Date and Time...

AutoText . See Figure |
Field...
Symbol... Footnote.., Cross-reference ﬁ
-4\ Comment ST Reference type: Insert reference to:
Reference ——> » Cross-reference.. —) E_IZI Entire caption IEI Figure 1
Web Component Index and Tables... Inzert as hyperlink Indude above below
Picture » Separate numbers with
{:3 Diagram... For which caption:
AJ Text Box -

-
File... Croszs-reference ﬁ

Object... Reference type: Insert reference to:

Bookmark... Figure = | |Entire caption
2 Sk Mumbered item -
= Hyperfink ek Heading Only label and number
Bookmark Only caption text
Footnote Page number
Endnote Abovebelow

=\ |Eguation

Table

Insert ] [ Close
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4. Insert > Reference - waexand Tables ... et
Index and Tables &J |

Insert l Format Tools Tab Index | Table of Contents | Table of Figures | Table of Authorities |

Break... Print Preview

» Anstotle 2|~ Type: @ Indented Run-n

= Asteroid belt............ See Jupiter Columns: 1 -
Date and Time... Artmosphere
Eanth language: | Engish (U.5.) B
AutoText »
exosphere ...

Field... Footnote... ionosphere -

Symbol... Caption...
_A Comment Cross-reference... |iRight align page numbers;

Reference ———> » Index and Tables... —) Tableader: ... E|

ch-Combanent Formats:  |From template |E|

Picture » MarkEntry... | [AutoMark... | [ Modify... |
t4 | Diagram... Mark Index Entry
: [ OK l | Cancel |
A-]| Text Box

: Index -

Object...

Bookmark... Options
. Hyperlink...  Ctrl+K Cross-reference: |5€3 |

@ Current page v
5 Page range
+ +
Alt+Shift+X a0 1200 = o

vay to create an index is after vou write and Fage number format
gindex entries as you write your document . create 1,2
tracts you from your prmmary task: witing. = _ document 1.2.3
a word or phrase while marking index entric Italic Entrv 1.2
sewhere n your : ick the Maﬂi‘_ This dialog box stays open =o that you can mark multiple index 1.2.3
x Entry dialog box. By clicking the Mark A T I 1
dex entry not only for the selected text, but: mf'r : e
= of the selected text within the document. Mark ] | Mark All | l Close Word 1
ran index ertry, Word activates the Show A
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4. Insert > Reference - wdexan Tables ... CupFins :

lnsertl Format Tools Tab

4

s
<o
e

l:

&

Break...

Date and Time...
AutoText »
Field...

Symbol...

Comment

éefé?egce —>
éiéture »
Diagram...

Text Box

File...

Object...

Bookmark...

Hyperlink...  Ctrl+K

Footnote...

LCaption...

Cross-reference...

Index and Tables...

—

Index and Tables

=

Table of Figures | Table of Authorities

Print Preview Web Preview
Heading 1 ... 1|* | |Heading 1 -
Heading 2 ... 3 Heading 2
Heading 5 ... 3 Heading 3
| Show page numbers | Use hyperlinks instead of page numbers
| Right align page numbers
Tab leader: |....... |Z|
General
Formats: | From template |Z| Show levels: |3 =

Show Qutlining Toolbar |

| Cptions... || Modify... |

3 Incheijere

4 Cuprins

i

2

3
i

1.1 Generalititi Heading 2
12  Prezemtare generald
21  Obiective.
22 Sarcimi

221 Lagcoald Heading 3..........coocee..ec

222 Acasi.o.

Ing
Cyl

[ Paste

BB b e

w

! Update Field

Edit Field...
Toggle Field Codes
Eont...

Paragraph...

il 4 =

Bullets and Numbering...

[

oK ]| Cancel |

| Paste
| 20 Update Field
/ Edit Field...
Toggle Field Codes
A Font..
= Baragraph...
:= | Bullets and Numbering...




4. Insert - Reference - indexand Tavles:

lnsertl Format Tools Tab

Break...

Date and Time...
AutoText »
Field...
Symbol...
-4 Comment
éefé?egce —>
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